
About
Gives copyright and author information on the program.



Add Ellipse Objects
Puts the program into Add Ellipses mode.



Add Headline Objects
Puts the program into Add Headlines mode.



Add Line Objects
Puts the program into Add Lines mode.



Add Picture Objects
Puts the program into Add Pictures mode.



Add Rectangle Objects
Puts the program into Add Rectangles mode.



Add Rounded Rectangle Objects
Puts the program into Add Rounded Rectangles mode.



Add Text Objects
Puts the program into Add Text mode.



Arrange Icons
Arranges the icons of any minimized windows at the bottom of the screen.



Border dialog box
The Border dialog box is where you decide what kind of border a text object will have.

Color
Click on the color that you want the border to be.

Size
Type in the size (in pixels) of the border.    If you type in 0, no border will appear. 

OK
Press this button to accept the changes made to the border.

Cancel
Press this button to cancel the changes made to the border.

Help
Press this button to get help on this dialog box.



Bottom button bar (text object formatting)
The controls on this bar are used for formatting text objects.    The controls will be active when a text object is the 
current object.    From left to right, the controls are: Change font, change font size, bold, italic, underline, left justify, 
right justify, center justify, justify both, left justified tab stop, right justified tab stop, decimal justified tab stop, and 
center justified tab stop.



Bring To Front
Puts the current object on top of all of the other objects (other than text objects).



Business Card Type dialog box
Connected
Press this button to select business cards that print out connected to each other.

Separated
Press this button to select business cards that print out in two separated columns.

Cancel
Press this button to close the dialog box without choosing a business card type.

Help
Press this button to get help on this dialog box.



Cascade
Arranges the windows in a cascading    (overlapped and slightly offset) format.



Center Horizontally
Centers the current object horizontally.



Center Vertically
Centers the current object vertically.



Close
Closes the current card.    If the current card has not been saved, you will be prompted to save it. 



Contents
Takes you to the help’s Table of Contents.



Copy
Copies the current object to the clipboard so that it can be pasted into a card.



Current Card
The current card is the card that is currently showing.    If more than one card is showing, the current card is the one 
with the highlighted title bar.



Current Object
The current object is the object that is highlighted with handles around it.    Since multiple objects can be selected at 
once, sometimes more than one object can be the current object.



Cut
Deletes the current object, but saves it in the clipboard so that it can be pasted back into a card.



Delete
Deletes the current object.



Down One Level
Exchanges the current object with the object directly below it (unless the current object is a text object).



Edit Description dialog box
Enter new description
Type in a new description for the existing template.

OK
Press this button to accept the new description.

Cancel
Press this button to cancel the new description.

Help 
Press this button to get help on this dialog box.



Edit Menu 
The Edit Menu has choices for manipulating objects with the program's clipboard (the Windows® clipboard is used 
for cutting and pasting text with text objects).

Cut

Copy

Paste

Delete

Select All



Edit Objects
Puts the program into Edit mode.



Edit Style dialog box
Enter new style name
Type in a new name for the existing style.

OK
Press this button to accept the new style name.

Cancel
Press this button to cancel the new style name.

Help 
Press this button to get help on this dialog box.



Ellipse Object
An ellipse object contains an ellipse and a border that can be resized.



Exit
Exits the program.    You will be prompted to save any open, unsaved cards.



File Menu 
The File Menu has choices for creating, opening, saving, and printing cards, and exiting the program.

New

Open

Close

Save

Save As

Save As Template

Print Preview

Print

Print Setup

Send

Exit



Font dialog box
The Font dialog box is where you choose a font to use with text objects.

Font
Choose the name of the font that you want to use.    Try to use TrueType™ fonts whenever possible (the ones with 
the TT symbol) because they will make your printed card look more like the one on the screen than other fonts.

Font Style
Changes the basic "look" of a font.

Size
Set the size (in points) that you want the font to be.    A point is 1/72 inch.

Strikeout
Draws a line through the middle of the letters in the font.

Underline
Underlines letters in the font.

Color
Changes the color of the font.    Some colors may not show up well on black and white printers.

Sample
Shows what the resulting font will look like.

OK
Press this button if you are satisfied with your choice of font.

Cancel
Press this button if you want to return to using the previous font.

Help
Press this button to get help on this dialog box.



Grid
The grid is an optional part of each card's display.    The grid is used to make the justification of objects easier by 
providing a backdrop to move the objects around on.    The grid size can be changed to provide different levels of 
resolution, and the grid can be set up so that objects will align on it.



Grid Size
Brings up a submenu that allows the user to set the grid size.    The grid size ranges from 1/32" to 1" (2 mm to 25 
mm if you are using the Metric system).    The current grid size is shown in this menu item, and is checked in the 
submenu.



Headline Object
A headline object is a block of text that can use different fonts, shadowing, and justification to give the effect that 
you want.



Headline Object Properties dialog box
The Headline Object dialog box is where you change the contents and appearance of headline objects.

Text
Type in the text of the headline object.    If you want to end a line before it wordwraps, press the Enter key where 
you want the line to end.    To enter text that can be personalized, surround a descriptive word or two with square 
brackets (example: [First Name]).

Font
Press this button to change the current font.    It will bring up the Font dialog box.

Shadow
Press this button to change the current shadow.    It will bring up the Shadow dialog box.

Border
Press this button to change the current border.    It will bring up the Border dialog box.

Clear Background
Check this box if you do not want a background color behind the text.

Delete Blank Lines
Check this box if you do not want to show any lines of text that are blank.

Center Horizontally
Check this box if you want the text of the headline object to always center itself horizontally.

Center Vertically
Check this box if you want the text of the headline object to always center itself vertically.

Background Color
Click on the color that you want behind the text.

Justification
Choose which justification you want the text to have.

Direction
Choose which direction you want the text to display in.

Default
Check this box to keep the current attributes as the default.

OK
Press this button to accept the changes made to the headline object.

Cancel



Press this button to cancel the changes made to the headline object.

Help
Press this button to get help on this dialog box.



Help
You can get help at any time by pressing the F1 key.    You can also press the help button (the one with the red 
question mark) while in the main window, or press the help button (the one marked "Help") while in a dialog box.    
Pressing F1 while a menu item is highlighted will give you help on that menu item.    Pressing F1 while not in a 
menu or pressing the button with the red question mark will show you the help's Table of Contents.    Pressing F1 
while in a dialog box or pressing a help button will give you help on the current dialog box.



Help Menu
The Help Menu accesses the program’s on-line help.

Contents

Topic Search

How To Use Help

About



How To Use Help
Shows you help on the Windows® help system.



Image Operations dialog box
The Image Operations dialog box has four parts which can be accessed separately by clicking on the tabs at the top 
of the dialog box.    The four parts are:

Information
Displays information about the current image.

Colors
Allows you to change the color format of the image.    Checking Gray Scale will remove all color information from 
the image.    Checking Dithering will use dithering (combining two existing colors in a pattern to form what looks 
like a new color) in video modes with only 16 or 256 colors.

Effects
Allows you to try different visual effects to change the image.    Checking Red, Green, and/or Blue will apply the 
effect to only the checked color(s).    If you choose the Brightness effect, you will also need to choose a value on the 
slider from -100 to 100.

Transform
Allows you to flip and rotate the image.    For certain flip/rotation choices, you will need to make other choices:

Choose the angle to rotate the image.

Checking Clip Corner will keep the image the same size, clipping any part of the image that is rotated outside of its 
original bounds.

Pressing the Background Color button will open a dialog box allowing you to choose the color that fills in the 
background when the image is rotated.

The buttons at the bottom of the dialog box are:

Preview
Shows what the image will look like with the changes that you have made.

OK
Saves the changes that you have made and exits the dialog box.

Cancel
Cancels the changes that you have made and exits the dialog box.

Help
Press this button for help on this dialog box.



Introduction
The Swift Business Card Magic program allows you to create an unlimited amount of cards for many styles.    You 
can use the clip art included with the program or your own clip art or fonts to make your own specialized cards.    
You can create generic card templates that can be personalized for different styles or people.    And you can do all 
this quickly and easily.

Useful terms
The following are some terms that are used repeatedly in the help:

Current Card

Object

Text Object

Headline Object

Picture Object

Line Object

Rectangle Object

Rounded Rectangle Object

Ellipse Object

Object Handles

Current Object

Mode



Line Object
A line object contains a line of a selected color, style, and size.



Line Object Properties dialog box
This dialog box is where you change the appearance of line objects.

Color
Click on the color that you want the line drawn in.

Style
Click on the style that you want the line drawn with.    Note that styles other than Solid cannot be used if the line 
width is greater than 1

Center Horizontally
Check this box if you want the line object to always center itself horizontally.

Center Vertically
Check this box if you want the line object to always center itself vertically.

Width
Type in the width (in pixels) of the line.    If you type in 0, the line will always have a width of 1, regardless of the 
current zoom level.

Default
Check this box to keep the current attributes as the default.

OK
Press this button to accept the changes made to the line object.

Cancel
Press this button to cancel the changes made to the line object.

Help
Press this button to get help on this dialog box.



Link Text Objects
This will allow you to link two text objects so that text from the first object will flow into the second one.    The 
program will be put into Link From mode.    Left click on the first text object to link, or right click to return to Edit 
mode.    After left clicking, left click on the second text object to link, or right click to return to Edit mode.    If you 
click on the same text object twice, this will cancel any link that the object currently has.



Main Window
The main window is where you edit the current card.

You can create a new object by first clicking on one of the mode buttons on the top button bar corresponding to the 
type of object that you want to create.    Then, hold down the left mouse button and drag the mouse to draw a shape 
that shows the outline of the object that you want.    When you are happy with the outline, release the left mouse 
button.    For objects other than text objects, you will then see a dialog box that will let you change the properties of 
the new object.

You can select an object by clicking on it with the left mouse button.    If more than one object is under the mouse 
cursor when you click, the top object will be selected.    You can select an additional object by holding down one of 
the shift keys when you click.    For a text object, you may have to move the mouse cursor to the outside edge of the 
object (where the mouse cursor will change to an arrow) before you can select it.    You can also select a group of 
objects in Edit mode by holding down the left mouse button outside of any objects, dragging the mouse to form a 
rectangle that encloses at least a part of any objects that you want to select, and releasing the left mouse button.

Once an object is selected, you can move it around on the current card by dragging it with the left mouse button.    
The mouse cursor will change to a hand to show when it is in the correct position to move the object.    For text 
objects, the mouse cursor will only change to a hand when you move it to the outside edge of the object.

You can resize an object by dragging one of the object's handles.    The mouse cursor will change to a two-headed 
arrow (or four-headed arrow for line objects) to show when it is in the correct position to resize the object.    The 
arrowheads will show in which directions the object can be resized.

Headline objects can only be resized to make them wider or thinner, not shorter or taller.    The height of a headline 
object is based on the width of the object and how the text wraps within that width.

Line objects can be forced to be straight while being created or resized by holding down a Shift key or a Ctrl key 
while dragging the mouse.    Holding down a Shift key will force the line to be vertical, and holding down a Ctrl key 
will force the line to be horizontal.

You can access a pop-up menu of commands to perform on an object by right-clicking on the object.



Menu Bar
The menu bar lets you choose commands to help you create your card.    The individual menus and commands are 
discussed in the Menus section of the help.



Menus
File Menu

Edit Menu

View Menu

Object Menu

Personalize

Window Menu

Help Menu



Minimize All
Minimizes all windows.



Mode
The program can be in one of several modes, which determines what a mouse click on the main window will do.    
You can tell which mode you are in by looking at the mouse cursor (except when the mouse is over a selected text 
object, in which case the mouse cursor will be an I-beam).    The modes (and their mouse cursors) are as follows:

Edit (an arrow)
Add Text (a page of text with a cross)
Add Headlines (a letter "A" with a cross)
Add Pictures (a page of various shapes with a cross)
Add Lines (a line with a cross)
Add Rectangles (a rectangle with a cross)
Add Rounded Rectangles (a rounded rectangle with a cross)
Add Ellipses (an ellipse with a cross)
Move (a grabbing hand)
Link From (a large page of text linking to a small page)
Link To (a small page of text linking to a large page)



New
Creates a new card.    You will be asked if you want to use a template (an existing card) to base your card on, or 
create a completely new card.    If you decide to use a template,    the Open Template dialog box will allow you to 
choose a style and description for the card so that you will have something to start with.    If you do not want to use a
template, the Business Card Type dialog box will come up so that you can select a business card type for the new 
card.    You can personalize the resulting card and change it as you wish.    All cards use letter-sized paper, or A4-
sized paper if you are using the Metric system.



New Picture dialog box
The New Picture dialog box is where you decide which picture to put in a picture object.

File Name
Type in the name of the picture file that you want to load in the edit box .    Only existing files are valid.    
Underneath is a list box which lists the picture files in the current directory.    Clicking the left mouse button on a file
name will put the file name in the File Name edit box.

List Files of Type
You can ignore this, as there is only one type of file (Pictures), although you can read in files with the extensions 
BMP, JPG, PCX, PNG, TGA, TIF, and WMF.

Directories
Lists the current directory, followed by a list box where you can change directories.    Double-click with the left 
mouse button on a directory name to make that directory the current one.

Drives
Bring down this list to choose a different drive to look for files on.

Preview
Check this box if you want to see each picture as it is selected in the File Name list box.

OK
Press this button if you are satisfied with the file name that you have selected.

Cancel
Press this button to stop trying to open a picture file.

Help
Press this button for help on this dialog box.



New Style dialog box
Enter new style name
Type in a name for the new style.

OK
Press this button to accept the new style.

Cancel
Press this button to cancel the new style.

Help 
Press this button to get help on this dialog box.



Next Object
Sets the current object to be the next object.    The next object is defined as the object that is on top of the current 
object.



Object
Every card is made up of objects.    Objects can be text objects, headline objects, picture objects, line objects, 
rectangle objects, rounded rectangle objects, or ellipse objects.    Objects are placed on the card to make it look like 
you want.    Objects can be placed on top of other objects, making other effects possible.



Object Handles
Objects can resized using the "handles" that appear around the edges of an object when it has been selected.    The 
handles look like black squares.    As the mouse cursor is moved over the handles, it changes to reflect the kind of 
resizing that the handle is capable of.



Object Menu 
The Object Menu changes the current object, adds new objects to the current card, or links together two text objects.

Bring To Front

Send To Back

Up One Level

Down One Level

Center Horizontally

Center Vertically

Properties

Edit Objects

Add Text Objects

Add Headline Objects

Add Picture Objects

Add Line Objects

Add Rectangle Objects

Add Rounded Rectangle Objects

Add Ellipse Objects

Link Text Objects



Open
Opens an existing card.    You will be prompted to choose the card to open from the Open Card dialog box.



Open Card dialog box
The Open Card dialog box is where you decide which existing card to load into the program.

File Name
Type in the name of the file that you want to load in the edit box .    Only existing files are valid.    Underneath is a 
list box which lists the files in the current directory.    Clicking the left mouse button on a file name will put the file 
name in the File Name edit box.

List Files of Type
You can ignore this, as there is only one type of file.

Directories
Lists the current directory, followed by a list box where you can change directories.    Double-click with the left 
mouse button on a directory name to make that directory the current one.

Drives
Bring down this list to choose a different drive to look for files on.

OK
Press this button if you are satisfied with the file name that you have selected.

Cancel
Press this button to stop trying to open a file.

Help
Press this button for help on this dialog box.

Network
Press this button (if it exists) to connect to network directories on other computers.



Open Template dialog box
The Open Template dialog box is where you choose which template you will base a new card on.

Style
Lists the possible styles to pick a template from.

Card Description
Lists the descriptions of templates from the currently highlighted style. 

Delete Style
Deletes all of the templates in the currently highlighted style.

Edit Style
Changes the name of the currently highlighted style using the Edit Style dialog box.

Delete Card
Deletes the template with the currently highlighted description.

Edit Description
Changes the description of the currently highlighted template using the Edit Description dialog box.

Template file name
Shows the name of the template's file, in case you want to edit the template directly.    Template files are in the 
TEMPLATE directory.

Card Type
Shows the card type of the currently highlighted template.

Card Text
Shows the text of all of the text objects in the currently highlighted template.

OK
Press this button to accept the currently selected template.

Cancel
Press this button to not create a new card.

Help
Press this button to get help on this dialog box.



Paste
Copies the object in the clipboard into the current card.    The object will appear as a selected object in the upper-left 
corner of the current card that you can move around on the screen.



Personalize 
The Personalize menu item will personalize the current card by asking you to enter specific information in places 
where general information was entered in the card.    When a card is created for a general style, you may want to use 
the card in many different cases.    To do this, you create a headline object in a way that tells the computer to prompt 
for specific information.    For example, instead of creating a headline object that says "In Business For 20 Years" 
you would create one that says "In Business For [years] Years".    When you choose the Personalize menu item, the 
program looks for all headline objects that contain words in square brackets, and prompts you to enter information 
corresponding to the words inside the square brackets using the Personalize dialog box.    In this example, the 
computer would prompt you to enter a value for "[years]".    If you typed in "10", the headline object's text would 
change to read "In Business For 10 Years".    Many of the template cards use this feature to speed up card creation.



Personalize dialog box
The Personalize dialog box is where you enter the personalized text for a card.

Original text
Shows the text before it has been personalized.

Enter personalized text for [???]
Type in the personalized text to replace [???] with.

OK
Press this button to accept the personalized text.

Cancel
Press this button to stop personalizing the card.

Help
Press this button for help on this dialog box.



Picture Object
A picture object contains a picture that can be resized and modified.    Note that your system should support more 
than 256 colors if you want good results using pictures with 256-color palettes.



Picture Object Properties dialog box
The Picture Object Properties dialog box is where you change the contents and appearance of picture objects.

Center Horizontally
Check this box if you want the picture object to always center itself horizontally.

Center Vertically
Check this box if you want the picture object to always center itself vertically.

New Picture
Press this button if you want to load in a new picture using the New Picture dialog box. 

Modify Picture
Press this button to make changes to the current picture using the Image Operations dialog box.

Restore to original size
Check this box if you want the picture object to be resized to its original size.

Default
Check this box to keep the current attributes as the default.

OK
Press this button to accept the changes made to the picture object.

Cancel
Press this button to cancel the changes made to the picture object.

Help
Press this button to get help on this dialog box.



Previous Object
Sets the current object to be the previous object.    The previous object is defined as the object that is underneath the 
current object.



Print
Prints the current card using the Print dialog box.    As the card is printing, you may receive instructions to flip the 
printed page over.    This step is necessary to make the card look correct after it is printed and folded.    You will 
probably need to practice with certain card types to make them look correct.



Print Preview
Shows what the current card will look like when it prints using the Print Preview dialog box.        You can use the 
Previous Page and Next Page buttons to see all of the pages in the current card.    For poster cards, text objects are 
too small to show up, so they will be visible as rectangles with a cross-hatch pattern.



Print Preview dialog box
This dialog box comes up when you want to see what a card will look like when it prints.    You will see both the 
front and back of the card as it will appear when printed.

Close
Press this button to close the dialog box.

Help
Press this button for help on this dialog box.



Print Setup
Changes the printer that you are using or sets up the current printer using the Print Setup dialog box.



Print Setup dialog box
The Print Setup dialog box lets you change the attributes of the currently selected printer.    This dialog box is 
different for every printer.    The standard controls are:

OK
Press this button when you are satisfied with the current printer setup.

Cancel
Press this button to restore the previous printer setup.



Print dialog box
This dialog box comes up just before you print a card.

Printer
Shows which printer is currently selected.

Print Range
Since you will always be printing an entire card, you can ignore this.

Print Quality
If your printer has different print quality modes, you can change the print quality by selecting one of the modes.

Copies
You should always leave this set to 1.

Collate Copies
Since you will always be printing one copy, you can ignore this.

OK
Press this button when you are ready to print.

Cancel
Press this button if you decide not to print.

Setup
Press this button to bring up the Print Setup dialog box.

Help
Press this button for help on this dialog box.



Program Window
The Program Window consists of a menu bar, two button bars, a ruler bar, a main window, and a status line with two
parts.    The menu bar allows you to select menu items (detailed in the following sections).    The button bars let you 
execute commands by pressing a button.    The main window is the background on which other windows will appear.
The status line shows help text for each of the menu items and buttons.

Menu Bar

Top button bar (commands)

Bottom button bar (text object formatting)

Ruler Bar

Main Window

Grid

Status line



Properties
Allows you to change the properties of the current object (unless the current object is a text object).    Different types
of objects use different dialog boxes to change their properties:

Headline objects: Headline Object Properties dialog box
Picture objects: Picture Object Properties dialog box
Line objects: Line Object Properties dialog box
Rectangle objects: Rectangle Object Properties dialog box
Rounded rectangle objects: Rounded Rectangle Object Properties dialog box
Ellipse objects: Ellipse Object Properties dialog box



Rectangle Object
A rectangle object contains a rectangle and a border that can be resized.



Rounded Rectangle Object
A rounded rectangle object contains a rectangle with rounded corners and a border that can be resized.



Ruler Bar
The ruler bar is used to show and change the indents and tab stops in the current text object.    The top half shows the
indents and tab stops, and the bottom half shows a ruler to help set the indents and tab stops.

At the left side of the ruler bar are two triangles.    The bottom triangle can be dragged to set the left indent.    The top
triangle can be dragged to set the indent for the first line of a paragraph.

At the right side of the ruler bar is a large triangle.    It can be dragged to set the right indent.

In the middle of the ruler bar are the active tabs.    There are four different types of tabs: left justified, right justified, 
decimal justified, and center justified.    These tabs can be dragged to change their position.    While being dragged, a 
tab's current position is shown at the far left of    the ruler bar.    If a tab is dragged off of the ruler bar, it will be 
removed.    To place a new tab, press the button on the bottom button bar corresponding to the type of tab that you 
want to create, and then left click on the ruler bar at the position of the new tab.



Save
Saves the current card.    If this is the first time you have saved the current card, you will be prompted to give it a 
name in the Save Card dialog box. 



Save As
Saves the current card under a different name, using the Save Card dialog box.    You would use this to save a 
modified card but still keep the original card.



Save As Template
Saves the current card as a template that can be used to create other cards.    The advantage of saving a card as a 
template as opposed to just saving it is that templates are grouped by style and description, so that users can tell 
what the card is without opening it.    When you save a card this way you first save it as a normal card file (press the 
Cancel button in the Save Card dialog box if you want to save the card as a template only), and then you assign the 
card to a style and give it a description with the Save Card As Template dialog box.



Save Card As Template dialog box
The Save Card As Template dialog box is where you add your own cards to the group of built-in templates.

Style
Lists the existing styles.

Card Description
Lists the descriptions of the templates in the currently highlighted style.

New Style
Press this button to add a new style to the group of styles using the New Style dialog box.

New Description
Type in a description of the card that you want to add to the templates.

OK
Press this button to add the card to the templates.

Cancel
Press this button to not add the card to the templates.

Help
Press this button to get help on this dialog box.



Save Card dialog box
The Save Card dialog box is where you decide which file name to give to a card.

File Name
Type in a name for the card that you want to save in the edit box .    If you type in the name of an existing file, you 
will be asked if you want to overwrite the file before leaving this dialog box.    Underneath is a list box which lists 
the files in the current directory.    Clicking the left mouse button on a file name will put the file name in the File 
Name edit box.

Save File as Type
You can ignore this, as there is only one type of file.

Directories
Lists the current directory, followed by a list box where you can change directories.    Double-click with the left 
mouse button on a directory name to make that directory the current one.

Drives
Bring down this list to choose a different drive to save files on.

OK
Press this button if you are satisfied with the file name that you have selected.

Cancel
Press this button to stop trying to save a file.

Help
Press this button for help on this dialog box.

Network
Press this button (if it exists) to connect to network directories on other computers.



Select All
Selects all of the objects in the current card that are on the screen.



Send
Sends the current card as electronic mail.    This feature is only available in the Windows 95® version of the 
program.



Send To Back
Puts the current object under all of the other objects (unless the current object is a text object).



Shadow dialog box
The Shadow dialog box is where you change the shadow properties of a text object.

Position
Set the position of the shadow in relation to the text.    Choose "None" for no shadow.

Color
Choose the color of the shadow.

Offset
Choose the offset (in pixels) of the shadow.    Larger fonts generally need a larger offset.

OK
Press this button to accept any changes that you have made to the shadow.

Cancel
Press this button to cancel any changes that you have made to the shadow.

Help
Press this button to get help on this dialog box.



Rectangle, Rounded Rectangle, and Ellipse Object 
Properties dialog box
These dialog boxes are where you change the contents and appearance of rectangle objects, rounded rectangle 
objects, and ellipse objects.

Color
Click on the color that you want the shape drawn in.

Clear
Check this box if you want a border only and not a filled shape.

Height = Width
Check this box if you want the height of the shape to be equal to its width.

Center Horizontally
Check this box if you want the shape to always center itself horizontally.

Center Vertically
Check this box if you want the shape to always center itself vertically.

Border Color
Click on the color that you want the border drawn in.

Border Size
Type in the size (in pixels) of the border.    If you type in 0, no border will appear. 

Default
Check this box to keep the current attributes as the default.

OK
Press this button to accept the changes made to the rectangle object, rounded rectangle object,    or ellipse object.

Cancel
Press this button to cancel the changes made to the rectangle object, rounded rectangle object, or ellipse object.

Help
Press this button to get help on this dialog box.



Show Grid
If checked, shows the grid on the screen.



Snap To Grid
If checked, will move objects to the nearest grid point whenever they are moved or placed.



Status line
The status line shows    help information.
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Text Object
A text object is a block of text that can be formatted like the text in a word processing card.    The text can use any 
combination of fonts, tabs, and paragraph formatting.    More than one text object can be linked together, allowing a 
single block of text to be spread over multiple columns or pages.    Unlike other objects, text objects are always on 
top of all other non-text objects.



Tile
Arranges the windows in a tiled    (non-overlapped) format.



Top button bar (commands)
The top button bar has buttons that correspond to menu commands.    When you click on a button, it performs the 
same command that the related menu item would have done.

The group of buttons to the left of the help button (the one with the red question mark) correspond to the first eight 
program modes.    Pressing one of these will put the program into the mode that the button represents.    Normally, 
the program switches back to Edit mode after you add a new object, but if you hold down a shift key at the same 
time that you press one of the buttons (other than the Edit mode button), that button will be "locked".    While the 
button is locked, it will not be released until you press one of the other buttons or link two text objects.

Currently disabled buttons are colored all in gray, and cannot be pressed.

If you need to know what a particular button does, move the mouse over it.    After a slight wait, a yellow box will 
pop up over the button that describes it.    This information will also appear on the status line.



Topic Search
Allows you to look up entries in the help alphabetically by name.



Up One Level
Exchanges the current object with the object directly above it (unless the above object is a text object). 



View Menu 
The View Menu changes the view of the current card by zooming in to it or zooming out from it, changing the 
current object, or changing the grid.

Zoom Out

Zoom In

Previous Object

Next Object

Show Grid

Snap To Grid

Grid Size



Window Menu 
The Window Menu arranges the program's windows on the screen.

Cascade

Tile

Arrange Icons

Minimize All



Zoom In
Zooms the view in to the current card.    The farthest view is 25%, and zooming in will change the view through the 
range 33%, 50%, 67%, 75%, 100%, 150%, 200%, and finally 250%.



Zoom Out
Zooms the view out from the current card.    The closest view is 250%, and zooming out will change the view 
through the range 200%, 150%, 100%, 75%, 67%, 50%, 33%, and finally 25%.




